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A propos de ce manuel
Présentation

Objectif du document
Le guide de démarrage rapide utilise un exemple d'application pour décrire les différentes étapes afin 
d'installer rapidement, de configurer et de commander le  TeSys U  Avec ce guide d'application rapide, 
vous pouvez facilement configurer un réseau de communication CANopen, sous réserve que vous 
connaissiez les bases des automates et des logiciels d'application (Unity Pro, Sycon, ...). L'exécution de 
cette tâche ne nécessite pas d'autres documents. 

Pour plus de détails sur les autres fonctionnalités des démarreurs TeSys U, consultez les documents 
associés indiqués ci-dessous.

Document à consulter

Vous pouvez télécharger ces publications et autres informations techniques depuis notre site web à 
l'adresse : www.schneider-electric.com.

Commentaires utilisateur
Envoyez vos commentaires à l'adresse e-mail techpub@schneider-electric.com

Titre de documentation Référence

Manuel d'utilisation du module de communication CANopen LULC08 1744084

Variables de communication TeSys U - Manuel d'utilisation 1744082

Mode d'emploi des démarreurs TeSys U LUB/LUS 1629984

Mode d'emploi des unités de contrôle LUCA/LUCB/LUCC/LUCD AAV40503

Manuel de configuration du matériel CANopen 35010857

Manuel d'utilisation des DFB disponibles pour les systèmes TeSys 1672600
1672604 01/2009
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Présentation
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Présentation 
Contenu de ce chapitre
Ce chapitre contient les sujets suivants :

Présentation de l'application

Présentation
L'exemple d'application vous pemet de définir les démarreurs directs (Direct On Line - DOL) étape par 
étape, afin de : 

fournir une protection magnéto-thermique
commander le moteur et
obtenir un retour du contacteur et un retour de déclenchement du disjoncteur.

Description de l'application
Moteur 1 (M1) :
moteur triphasé, classe 10, 5,5 kW (7,4 cv) à 440 V, 50 Hz, courant nominal En = 10,5 A, démarrage 
direct 
Moteur 2 (M2) :
moteur triphasé, classe 20, 7,5 kW (10,1 cv) à 440 V, 50 Hz, courant nominal En = 14,7 A, démarrage 
direct avec contrôle à distance de la charge du moteur.

Solution traditionnelle
Le schéma ci-dessous illustre le câblage utilisé dans la solution traditionnelle : toutes les informations de 
commande et de retour sont câblées à travers un automate.

Sujet Page

Présentation de l'application 5

Solution Schneider Electric avec démarreur Tesys U 6

Schéma d'alimentation Schéma de commande
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Présentation
Solution Schneider Electric avec démarreur Tesys U

Schémas d'alimentation et de commande dans la solution Schneider Electric

Unités de contrôle utilisées dans la solution Schneider Electric
La solution Schneider Electric présentée dans ce guide de démarrage rapide utilise le TeSys U pour 
répondre aux différents besoins des clients.

LUCA12BL est une unité de contrôle standard utilisée avec le moteur 1 pour les besoins de base :
commande à distance un moteur (démarrage/arrêt)
fournit les informations d'état (prêt, en marche, défaut)

LUCD18BL est une unité de contrôle avancée utilisée avec le moteur 2 pour les besoins avancés, en 
plus des besoins standards :

alarme
réarmement automatique et à distance par le bus
indication de la charge moteur
différenciation des défauts

Schéma d'alimentation Schéma de commande

1. TSXCPP110 coupleur principal CANopen avec carte 
PCMCIA boîtier de connexion
2. câble TSXCANC•• avec connecteur 
TSXCANKCDF90T
3. dérivation TSXCANTDM4 avec 4 connecteurs sub-D 
pour la raccordement en nœud et les bornes à vis (24V 
et raccordement du bus au module LULC08)
4. raccordement de bobine précâblée LU9BN11L

A
1

A
2

LUCAppBL

5.5 kW

Q1
KM1

M1

440 V 50 Hz

TeSys U TeSys U

A
1

A
2

A
1

A
2

A
1

A
2

LUCDppBL

LULC08

CANopen
bus
24 Vdc

CANopen
bus
24 Vdc

LULC08

7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

2

1

4 4

LUCDppLUCApp

LULC08 LULC08

TeSys UTeSys U

24 Vdc

3
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Présentation
Architecture du système TeSys U
L'architecture suivante décrit les principaux composants du système TeSys U monté sur une plaque :

Légende Référence commerciale Description

1 Premium Programmable Logic Controller (automate programmable industriel)

Modicon M340

2 TSXCPP110 Carte PC CANopen (pour Premium uniquement)

3 TSXCANKCDF90T Connecteur à angle droit

4 TSXCANCA50 Câble, maximum 50 m (164 ft)

5 TSXCANTDM4 Dérivation avec 4 connecteurs sub-D (24 V et raccordement bus)

6 TSXCANKCDF180T Câble et connecteur (côté esclave) (avec terminaison de ligne = OFF)

7 LUB12 Base puissance TeSys U

8 LUCA12BL Unité de contrôle standard

9, 12 LULC08 Module de communication CANopen

10 LUB32 Base puissance TeSys U

11 LUCD18BL Unité de contrôle avancée

13 TSXCANKCDF180T Raccordement de chaînage avec câble d'environ 1 m et connecteur (avec 
terminaison de ligne  = ON)

14 LU9BN11L Raccordement de bobine précâblée (en option) ou  

15 (raccordement standard 
avec le LULC08)

Bornier enfichable, pour contrôle fil à fil pour des bornes A1/A2

1 2 3 54 6 7 8 9

13

10

11

12

15 14
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Présentation
Outils logiciels
Les outils logiciels suivants doivent être utilisés pour définir les applications. Leur utilisation nécessite une 
connaissance de base.

Conditions réseau
Protocole : CANopen

Débits en bauds : 500 kbps

Adresses :
1 pour moteur 1 TeSys U
2 pour moteur 2 TeSys U

Stratégie de repli :

En cas de perte de communication avec l'automate, la stratégie de repli permet d'actionner un moteur de 
différentes façons. Définissez le paramètre 682 sur l'une des valeurs suivantes :

La stratégie de repli adaptée à l'application est :
Valeur 1 = Figé pour le moteur 1
Valeur 2 = Arrêt forcé pour le moteur 2

Référence commerciale Description

Unity Pro
Unity Pro XL V4.0 (et versions supérieures) 

Plate-forme de programmation.
Logiciel de programmation pour automates Premium et M340.

SYCSPULFUCD29M Logiciel de configuration de réseau Sycon V2.9 pour automate 
Premium (une seule licence d'utilisation). 

 Ctrl_cmd_u Commande/contrôle cyclique du TeSys U Téléchargez la 
bibliothèque des DFB TeSys U sur le site Internet www.schneider-
electric.com  (voir page 19).

Valeur Mode de repli Description

0 Désactivée Aucune stratégie appliquée. Non recommandé.

1 Figé En cas de détection de perte de communication, le moteur conservera son 
statut :

Si le moteur est en marche, il continuera de tourner.
Si le moteur est arrêté, il restera dans cet état.

Aucune modification du statut de commande n'est autorisée. Une nouvelle 
commande ne sera prise en compte qu’après un réarmement sur perte de 
communication (703.3)

2 Arrêt forcé (valeur par 
défaut)

Le moteur est forcé de s'arrêter.
Sortie OA1= 0
Sortie OA3 = 0

3 Inchangé Les modifications du statut de commande sont autorisées. Une nouvelle 
commande sera prise en compte même avant un réarmement sur perte de 
communication (703.3)

4 Forcé en marche en sens 
direct

Sortie OA1= 1 (direct) 
Sortie OA3 = 0

5 Forcé en marche en sens 
inverse

Sortie OA1= 0
Sortie OA3 = 1 (sens inverse)
8 1672604 01/2009
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1672604   01/2009
Configuration du TeSysU
Contenu de ce chapitre
Ce chapitre contient les sujets suivants :

Réglages des LUCA12BL et LUCD18BL

Régler le courant sur les unités de contrôle
La figure ci-dessous illustre comment régler le courant sur l'unité de contrôle à l'aide d'un tournevis (ici 
LUCA12BL) :

Valeurs de réglage du courant
Le tableau ci-dessous présente les réglages pour le LUCA12BL (unité standard) et le LUCD18BL (unité avancée) :

Sujet Page

Réglages des LUCA12BL et LUCD18BL 9

Connecteurs, débit en bauds et réglage d'adresse du LULC08 10

4.00A

LUCA / LUCD

LULC08

5.00A

7.00A

9.00A

12.0A

3.00A

TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Unité de contrôle Moteur Plage de réglage du 
courant

Puissance nominale 
du moteur

Valeur de réglage du 
courant = Courant 
nominal du moteur

LUCA12BL M1 3..12 A 5,5 kW (7,4 cv) 10,5 A

LUCD18BL M2 4.4..18 A 7,5 kW (10,1 cv) 14,7 A
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Configuration du TeSys U
Connecteurs, débit en bauds et réglage d'adresse du LULC08 

Présentation
A l'aide des commutateurs DIP, sous le module de communication LULC08, réglez l'adresse et le débit 
en bauds du CANopen.

1 Connecteur à 9 broches de catégorie Sub-D CANopen
2 Bornier Entrée/Sortie et 24 V CC
3 Débit en bauds
4 Adresse

Débit en bauds
Définissez un débit en bauds (10, 20, 50, 125, 250, 500, 800 et 1 000 kbps) à l’aide des trois 
commutateurs situés à l’extrême gauche (SW8 à SW10). 

Dans l'application, le débit en bauds est de 500 kbps :

Adresse
Définissez une adresse de 1 à 127 à l'aide des 7 commutateurs les plus à droite (SW1 à SW7). L’adresse 
0 (zéro) n’est pas autorisée et constitue une configuration invalide.

Dans l'application, les adresses sont 1 et 2 :

4321

LO1LI1LI2
24V c

1 2 3 4

6 7 8 9

(GND)
CAN_H

CAN_V+

5

CAN_L
CAN_GND

(CAN_SHLD)

SW10 SW9 SW8 Débit en bauds

1 0 1 500 kbps 

SW10 SW9 SW8

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1 Adresse

0 0 0 0 0 0 1 1 (valeur par défaut)

0 0 0 0 0 1 0 2

Adresse 1 pour le moteur 1 TeSys U Adresse 2 pour le moteur 2 TeSys U

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off
10 1672604 01/2009
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Configuration d'un réseau de communication vers un automate
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Configuration d'un réseau de communication 
vers un automate
Présentation
Ce chapitre décrit de façon détaillée comment établir une communication vers un automate.

Le tableau ci-dessous indique le logiciel nécessaire pour établir une communication en fonction de 
l'automate utilisé dans l'application.

Contenu de ce chapitre
Ce chapitre contient les sujets suivants :

API Logiciel utilisé pour établir la communication

Premium Unity Pro et
Sycon

Modicon M340 Unity Pro

Sujet Page

3.1 Configuration du TeSys U sur le réseau CANopen avec Unity Pro et Sycon (pour un automate 
Premium)

12

3.2  Configuration du TeSys U sur le réseau CANopen avec Unity Pro (pour un automate M340) 16

3.3. Configuration des DFB avec l'application 19
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Configuration d'un réseau de communication vers un automate
3.1 Configuration du TeSys U sur le réseau CANopen avec Unity Pro et Sycon (pour un automate Premium)

Processus de configuration d'un automate Premium

1)  Téléchargement des fichiers EDS
Le tableau suivant présente la procédure de téléchargement des EDS et fichiers icône associés au 
Tesys U à partir du site Web www.schneider-electric.com :

Le tableau ci-dessous indique les associations entre les 2 variantes TeSys U et les noms de fichiers EDS associés.

Les lettres Sc signifient Starter-Controller (démarreur-contrôleur).
Les lettres St et Ad signifient respectivement unités Standard et Avancée.

Étape Action

1 Accédez au site Web de Schneider Electric à l’adresse suivante : www.schneider-electric.com.

2 Cliquez sur Produits et Services, puis sur Automatismes et Contrôle.

3 Dans la section Downloads (Téléchargements) située dans la barre de menu à gauche, cliquez sur 
Current offers (Offres actuelles).

4 Dans la liste déroulante Choose a function (Choisir une fonction), sélectionnez Motor Control 
(Commande moteur).
Dans la liste déroulante Choose a range (Choisir une gamme), sélectionnez TeSys U.
Dans la liste déroulante Choose a type of document (Choisir un type de document), sélectionnez 
Software/Firmware (Logiciels/Micrologiciels).

Cliquez sur >Find (Rechercher).

5 Sélectionnez Communication Module Tesys U Canopen (Module de communication Tesys U 
Canopen) et téléchargez le fichier LULC08_EDS_DIB_files_V100.exe.

6 Double-cliquez sur LULC08_EDS_DIB_files_V100.exe sur votre disque dur. Cliquez sur Accept 
(Accepter) dans la fenêtre "Licence for software downloaded from Schneider-Electric web sites" 
(Licence du logiciel téléchargé sur les sites Schneider-Electric) qui s'ouvre puis naviguez jusqu'au 
fichier de destination et cliquez sur Install (Installer).

7 Sélectionnez les 2 fichiers EDS correspondant à vos 2 configurations TeSys U :
TE_TESYSU_SC_ST0102E.eds
TE_TESYSU_SC_AD0102E.eds

Noms de variantes Noms de fichier EDS Moteurs (pour l'application)

TeSys U Sc St TE_TESYSU_SC_ST0102E.eds Moteur 1

TeSys U Sc Ad TE_TESYSU_SC_AD0102E.eds Moteur 2
12 1672604 01/2009



Configuration d'un réseau de communication vers un automate
2) Configuration du réseau d'application
Les premières étapes de configuration avec le logiciel Unity Pro XL sont décrites ci-dessous :

 
Poursuivez le processus de configuration avec le logiciel Sycon, comme décrit ci-dessous :

Étape Action

1 Démarrez le logiciel Unity Pro XL V4.0.

2 Configurez votre automate Premium et les accessoires de communication (carte PCMCIA, etc.) :

3 Enregistrez votre application comme un fichier .STU.

4 Double cliquez sur la carte PCMCIA. La fenêtre CANopen PCMCIA CARD s'ouvre :

Il est inutile de l'éditer. 
Pour poursuivre le processus de configuration, cliquez sur Sycon. S'il n'est pas affiché, intallez à 
nouveau le logiciel Sycon.

Étape Action

1 Dans le logiciel Sycon V2.9, cliquez sur File → New (Fichier - Nouveau).

2 Dans la boîte de dialogue Select fieldbus , choisissez CANopen et validez.

3 Importez votre fichier EDS en cliquant sur File → Copy EDS (Fichier - Copier EDS).

4 Naviguez jusqu'à votre fichier TE_TESYSU_xxx.eds.

5 Insérer un maître : 
- cliquez sur Insert → Master... (Insérer - Maître...) ou
- sélectionnez .

6 Dans la fenêtre Insert Master (Insérer maître), sélectionnez le TSXCPP110 dans la liste Available 
masters (Maîtres disponibles). 
Cliquez sur Add>> (ajouter) et confirmer en cliquant sur OK.

7 Insérer nœud : 
- cliquez sur Insert → Node... (Insérer - Noeud...) ou
- sélectionnez .
1672604 01/2009 13



Configuration d'un réseau de communication vers un automate
8 Dans la fenêtre Insert Node (Insérer noeud), sélectionnez le TeSysU_Sc_St puis TeSysU_Sc_Ad 
dans la liste Available nodes (Noeuds disponibles). 

TeSysU_Sc_St se trouve à l'adresse 1. TeSysU_Sc_Ad se trouve à l'adresse 2.

9 Pour définir le paramètre du bus, sélectionnez Settings → Bus Parameter (Réglages-Paramètre du 
bus) :

Sélectionnez le Baudrate (débit en bauds) à 500kBit/s et confirmez en cliquant sur OK.

10 Cliquez deux fois sur un noeud pour ouvrir la fenêtre Node Configuration (Configuration du noeud). 
Cliquez sur Object Configuration (Configuration de l'objet). La fenêtre correspondante s'ouvre :

Pour Node1 (TeSysU_Sc_St), définissez la stratégie de repli sur perte de communication : 1 (figé).
Pour Node2 (TeSysU_Sc_Ad), conservez la stratégie de repli sur perte de communication par 
défaut : 2 (arrêt).

L'adresse CANopen (avec index:sous-index) pour la stratégie de repli sur perte de communication est 
2007:21. Sélectionnez-la dans la zone supérieure puis éditez-la dans la zone inférieure. 

11 Sauvegardez votre configuration en cliquant sur File → Save as  (Fichier - Enregistrer sous). Votre 
fichier de configuration présentera une extension .CO.
Quittez le logiciel Sycon.

Étape Action
14 1672604 01/2009



Configuration d'un réseau de communication vers un automate
 
Terminez le processus de configuration avec le logiciel Unity Pro XL, dans la fenêtre CANopen PCMCIA CARD : 

3)  Execution d'un test fonctionnel du réseau de communication, notamment les produits et l'automate Premium 

Étape Action

1 Cliquez sur Select Database  (Sélectionner base de données) et ouvrez le fichier .CO.

2 Sélectionnez Edit → Validate (Editer - Valider) pour valider la configuration. 
NOTE : Une erreur peut être indiquée si les valeurs des entrées ou sorties sont incorrectes. 

• Nb of words (%MW) (Nbr de mots %MW) doit être au moins 13 pour les entrées et 14 pour les sorties. 
• Index of 1st %MW (Index 1er %MW) doit être 0 pour les entrées et au moins 13 pour les sorties. 
Si vous modifiez les valeurs, validez à nouveau.

3 Sélectionnez Build → Rebuild all project (Créer - Recréer tout le projet).

Étape Action

1 Branchez le câble de programmation approprié de votre ordinateur à l'automate Premium.

2 Mettez l'automate Premium sous tension.

3 Cliquez sur Connect (Connecter).

4 Cliquez sur le menu PLC : la fenêtre Transfer Project To PLC (Transférer le projet vers automate) 
s'ouvre. Cliquez sur Transfer (Transférer).

5 Mettez les 2 systèmes TeSys U sous tension : la DEL verte STATUS (statut) à l'avant du LULC08 clignote 
puis reste allumée.

6 La communication doit fonctionner correctement.
NOTE : Dans le cas contraire, (soit la DEL verte STATUS continue de clignoter soit la DEL rouge ERR 
est allumée), consultez le manuel d'utilisation du CANopen LULC08 TeSys U.

7 La fenêtre CANopen PCMCIA CARD présente un onglet Debug (Mise au point). Les tableaux ci-
dessous sont extraits de cet onglet, avec les adresses contenant les échanges cycliques par équipement. 
Nommez les variables de façon à lire les informations relatives à l'emplacement de la mémoire (par ex. 
Reg_455_moteur_1 au lieu de %IW\3.1\0.0.0.0).

L'onglet suivant dans la fenêtre CANopen PCMCIA CARD est l'onglet Fault (défaut). Il est généralement 
désactivé sauf en cas de problème de communication. Une bille rouge s'affiche dans le carré gris avant 
son nom et une page diagnostic s'ouvre.

Inputs

%IW\3.1\0.0.0.0

%QW\3.1\0.0.0.0

Reg_455_motor_1

Reg_704_motor_1

1

0

%IW\3.1\0.0.0.1

%QW\3.1\0.0.0.1 Reg_703_motor_1

0

0

%IW\3.1\0.0.0.2

%QW\3.1\0.0.0.2

0

0

%IW\3.1\0.0.0.3

%QW\3.1\0.0.0.3

0

0

Parameters Symbol Value

Parameters Symbol Value
Outputs
1672604 01/2009 15



Configuration d'un réseau de communication vers un automate
3.2  Configuration du TeSys U sur le réseau CANopen avec Unity Pro (pour un automate M340)

Processus de configuration pour un automate Modicon M340

1) Configuration du réseau d'application
Les étapes de configuration avec le logiciel Unity Pro XL sont les suivantes :

Étape Action

1 Démarrez le logiciel Unity Pro XL V4.0.

2 Configurez l'automate Modicon M340 pour le CANopen :
A partir du menu File (fichier), créez un nouveau projet.
Dans la fenêtre New Project (Nouveau projet), déroulez la liste Modicon M340 et sélectionnez BMX 
P34 2010 (CPU 340-20 Modbus CANopen).

Confirmez en cliquant sur OK.

3 A partir de l'arborescence du Navigateur de projet, sélectionnez Configuration → 0 : PLC bus → 
0 : BMX XBP 0800 → 0 : BMX P34 2010 ou double-cliquez sur le module P34 2010 dans la 
configuration. L'écran Communicator head CANopen s'ouvre dans un nouvel onglet :

4 Sélectionnez Configuration → 3 : CANopen. 
16 1672604 01/2009



Configuration d'un réseau de communication vers un automate
5 Dans l'onglet CANopen , double-cliquez sur l'équipement :

Une fenêtre pop-up New Device  (nouvel équipement) s'ouvre.

6 Dans la fenêtre New Device , définissez la configuration du premier équipement TeSys U comme suit :
Sélectionnez CANopen drop → Motor control  → TeSysU_Sc_St
Réglez Topological Address (l'adresse topologique) sur 1
Confirmez en cliquant sur OK.

7 Ouvrez l'autre fenêtre New Device , définissez la configuration du second équipement TeSys U comme 
suit :

Sélectionnez CANopen drop → Motor control  → TeSysU_Sc_Ad
Réglez Topological Address (l'adresse topologique) sur 2
Confirmez en cliquant sur OK.

8 Les 2 modules TeSys U et les branchements s'affichent dans l'onglet CANopen. 

Cliquez sur chaque image d'équipement au fur et à mesure. Un tableau de configuration apparaît dans 
lequel vous pouvez configurer la stratégie de repli sur perte de communication :

Pour TeSysU_Sc_St, définissez la stratégie de repli sur perte de communication : 1 (figé).
Pour TeSysU_Sc_Ad, conservez la stratégie de repli sur perte de communication par défaut : 2 (arrêt).

Étape Action
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Configuration d'un réseau de communication vers un automate
2)  Execution d'un test fonctionnel du réseau de communication, notamment les produits et l'automate M340 

9 Sélectionnez Edit → Validate (Editer - Valider) pour valider la configuration. 
NOTE : Un message peut s'afficher dans la zone Rebuild All Project (recréer tout le projet) au sujet 
du nombre E/S de mots et de bits réservés. Dans ce cas, revenez à l'écran Configuration et saisissez 
les valeurs indiquées dans le message.

Configurez les options conformément à l'exemple d'application : 

Définissez la vitesse de transmission jusqu'à 500 kBauds.
Nb of words (%MW) (Nbr de mots %MW) doit être 28 pour les entrées et 20 pour les sorties.
Index of 1st%MW (Index du 1er %MW) doit être 0 pour les entrées et 100 pour les sorties.
Nb of bits (%M) (Nbr de bits) doit être 0 pour les entrées et les sorties.

10 Sélectionnez Créer → Recréer tout le projet pour recréer tout le projet. Une fois les valeurs corrigées, 
l'état NOT BUILT (non créé) devient BUILT (créé).

11 Enregistrez l’application avec un nom spécifique.

Étape Action

Étape Action

1 Par le port USB sur votre ordinateur, branchez un câble (par ex. TSXPCX3030) sur l'automate M340.

2 Mettez l'automate M340 sous tension.

3 Cliquez sur Connecter.

4 Clique sur le PLC (automate) : la fenêtre Transfer Project to PLC (Transférer le projet vers l'automate) 
s'ouvre. Cliquez sur Transfer (Transférer).

5 Mise sous tension des 2 systèmes TeSysU : la DEL verte STATUS (statut) à l'avant du LULC08 clignote 
puis reste allumée. La communication fonctionne correctement.
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3.3. Configuration des DFB avec l'application

Présentation
Les DFB (Derived Function Blocks - Blocs fonction dérivés)  TeSys ont été développés pour faciliter et 
optimiser l'intégration des démarreurs-contrôleurs TeSys U dans les applications d'automate.

Le DFB Ctrl_cmd_u est destiné au contrôle et à la commande d'un seul démarreur-contrôleur TeSys U  
(jusqu'à 32 A/15 kW) via les échanges cycliques de données sur un réseau CANopen.

1. Téléchargement des fichiers DFB
2. Installation du DFB dans Unity Pro
3. Extraction de votre projet et de l'application DFB dans Unity Pro

Pour de plus amples informations, reportez-vous au manuel d'utilisation des DFB TeSys :

1) Téléchargement des fichiers DFB
Le tableau suivant présente la procédure de téléchargement des TeSys DFB à partir du site Web 
www.schneider-electric.com :

2) Installation du DFB dans Unity Pro

Étape Action

1 Accédez au site Web de Schneider Electric à l’adresse suivante : www.schneider-electric.com

2 Cliquez sur Produits et Services, puis sur Automatismes et Contrôle.

3 Dans la section Downloads (Téléchargements) située dans la barre de menu à gauche, cliquez sur 
Current offers (Offres actuelles).

4 Dans la liste déroulante Choose a function (Choisir une fonction), sélectionnez Motor Control 
(Commande moteur).
Dans la liste déroulante Choose a range (Choisir une gamme), sélectionnez TeSys U.
Dans la liste déroulante Choose a type of document (Choisir un type de document), sélectionnez 
Software/Firmware (Logiciels/Micrologiciels).

Cliquez sur >Find (Rechercher).

5 Sélectionnez TeSys DFB offer package (ensemble DFB TeSys) et téléchargez le fichier zippé sur votre 
disque dur.

6 Importez le fichier TeSys DFB offer package.zip vers un répertoire unique sur votre disque dur. 2 
répertoires, PL7 et Unity Pro, seront créés, chacun contenant les dossier suivants :

Étape Action

1
A partir du menu Démarrer  Start, Tous les programmes, naviguez jusqu'à  Schneider Electric 
→ Unity Pro → Types Library Update (Mise à jour bibliothèque de types).

2 Dans la fenêtre Types Library Update, naviguez jusqu'à 04 Cyclic control command  → 
FAMILY.DSC (commande contrôle cyclique 04 - Famille.dsc) et ouvrez. 
NOTE : La version d'application que vous sélectionnez doit être conforme à Unity Pro.

3 Cliquez sur Install family (Installer famille). Une fenêtre pop-up s'ouvre avec le message suivant : 
"Installation réussie". Puis quittez.
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3) Extraction de votre projet et de l'application DFB dans Unity Pro

Caractéristiques d'entrées
Le tableau suivant décrit les entrées des DFB ainsi que leur disponibilité selon l'unité de contrôle :

Étape Action

1 Démarrez le logiciel Unity Pro.

2 A partir du menu Tools (Outils), allez au sous-menu Type Library Manager (gestionnaire de la 
bibliothèque de type). Cliquez sur lAccess Assistant  (Atteindre l'assistant). Sélectionnez Ctrl_cmd_u 
et déplacez-le à droite jusqu'à la zone intitulée Objects to get (objets à trouver) :

Cliquez sur Copy into project (Copier dans le projet).

3 La représentation graphique DFB s'affiche :

Ctrl_cmd_u

Reg_704

Run_fwd
Run_rev

Rst_flt
Rst_warn

Ther_ov_test
Trip_tst

Closed
Ready

Tripped

1

Reg_455
Reg_703

Alarm
Fault

Rst_auth

Running
Starting

Avg_curr

Entrée Type Plage Valeur par 
défaut

Description LUCA LUCD

Reg_455 INT 0...65535 0 Liaison vers le registre 455 de données d'entrée 
cycliques

√ √

Run_fwd EBOOL 0...1 0 Commande de marche directe du moteur √ √

Run_rev EBOOL 0...1 0 Commande de marche inverse du moteur √ √

Rst_flt EBOOL 0...1 0 Réinitialisation (en cas de défaut interne du 
module de communication, réinitialise le module 
de communication aux paramètres d'usine).

√ √

Rst_warn EBOOL 0...1 0 Alarme de réarmement (par exemple, perte de 
communication)

√ √

Ther_ov_test EBOOL 0...1 0 Test de défaut de surcharge thermique 
automatique

  

Trip_tst EBOOL 0...1 0 Test de déclenchement de surintensité via le bus 
de communication
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Configuration d'un réseau de communication vers un automate
Caractéristiques de sorties
Le tableau suivant décrit les sorties des DFB ainsi que leur disponibilité selon l'unité de contrôle :

Programmation des DFB 1 pour le moteur 1

Sortie Type Plage Valeur par 
défaut

Description LUCA LUCD

Reg_704 INT 0...65535 0 Liaison vers le registre 704 de données de sortie 
cycliques

√ √

Reg_703 INT 0...65535 0 Liaison vers le registre 703 de données de sortie 
cycliques

√ √

Ready EBOOL 0...1 0 Système disponible<:hs>: la poignée rotative est 
tournée en position On et aucun défaut n'est 
détecté

√ √

Closed EBOOL 0...1 0 Etat du pôle : fermé √ √

Tripped EBOOL 0...1 0 Système déclenché : la poignée rotative est 
tournée en position Trip

√ √

Fault EBOOL 0...1 0 Tous les défauts √ √

Alarm EBOOL 0...1 0 Toutes les alarmes √ √

Rst_auth EBOOL 0...1 0 Réinitialisation du défaut autorisée  √

Starting EBOOL 0...1 0 Démarrage en cours :
1 = le courant croissant est supérieur à 10 % FLA
0 = le courant décroissant est inférieur à 150 % 
FLA

 √

Running EBOOL 0...1 0 Moteur en marche avec détection d'un courant, si 
supérieur à 10 % de FLA

 √

Avg_curr INT 0...200 0 Courant moteur moyen (% FLA)  √

Étape Action

1 Nommez les registres d'automate (%IW..., %QW...) correspondant aux registres TeSys U (455, 703 et 
704)
Pour le noeud 1 (TeSys U_Sc_St) :

Reg_455_M1 : %IW\3.1\0.0.0.0
Reg_704_M1 : %QW\3.1\0.0.0.0
Reg_703_M1 : %QW\3.1\0.0.0.1

2 Associez l'entrée DFB1 Run_fw à la condition de démarrage du moteur 1.

3 Associez les sorties DFB 1 aux variables d'automate pour l'utilisation dans le programme :
Sortie DFB 1 fermée = position du contacteur KM1
Sortie DFB 1 déclenchée = position déclenchée du Q1 TeSys U

4 Vérifiez que le DFB 1 pour le moteur 1 s'affiche comme suit :

1 Non applicable
2 Applicable mais non utilisé, peutt être géré par l’application de l’automate.

Ctrl_cmd_u

Reg_704

Run_fwd
Closed

Tripped

1

Reg 455
Reg_703

Q1 tripped position
KM1 position

Reg_703_M1
Reg_704_M1Reg_455_M1

KM1 close command

Rst_flt2

Rst_warn2

Ther_ov_test1

Trip_tst1

Alarm2

Fault2

Rst_auth1

Running 1

Starting1

Run_rev2

Ready2

Avg_curr1
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Programmation des DFB 2 pour le moteur 2

Étape Action

1 Nommez les registres d'automate (%IW..., %QW...) correspondant aux registres TeSys U (455, 703 et 
704)
Pour le noeud 2 (TeSys U_Sc_Ad) :

Reg_455_M2 : %IW\3.2\0.0.0.0
Reg_704_M2 : %QW\3.2\0.0.0.0
Reg_703_M2 : %QW\3.2\0.0.0.1

2 Associez l'entrée DFB 2 à la condition de démarrage du moteur 2.

3 Associez les sorties DFB 2 aux variables d'automate pour l'utilisation dans le programme :
Sortie DFB 2 fermée = position du contacteur KM2
Sortie DFB 2 déclenchée = position déclenchée du Q2 TeSys U

4 Associez la sortie DFB 2 Avg_curr à un registre d'automate pour utiliser le courant moyen du moteur 2 
dans le programme.

5 Vérifiez que le DFB 2 pour le moteur 2 s'affiche comme suit :

1 Non applicable
2 Applicable mais non utilisé, peutt être géré par l’application de l’automate.

Ctrl_cmd_u

Reg_704

Run_fwd
Closed

Tripped

2

Reg 455
Reg_703

Avg_curr Average M2 current

Q2 tripped position
KM2 position

Reg_703_M2
Reg_704_M2Reg_455_M2

KM2 close command
Run_rev2

Rst_flt2

Rst_warn2

Ther_ov_test1

Trip_tst1

Ready2

Alarm2

Fault2

Rst_auth2

Running2

Starting2
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